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NEW FEATURES

In this section new features and enhancements to the NISA suite are presented.

PRE & POST PROCESSORS

New features in DISPLAY Ill and DISPLAY IV modules are explained in the following
sections. These developments are enhancements to the pre and post processing
capabilities of solver modules such as NISA II, NISA/DYNAMICS, FLUID, HEAT III and
EMAG. This also covers the DISPLAY IV Graphical User Interface enhancements.

Pre-Processor in DISPLAY Il & DISPLAY IV

1.

Advanced Tetrahedral Mesher (ATM):

This feature has the ability to create tetrahedral mesh from an existing linear
Tri/Quad surface mesh. Surface mesh can be generated using Advanced
Surface Mesher (ASM) facility in DISPLAY, or imported from any other third party
software.

FEM->Mesh->Adv Tet Mesher

Cptimization Lesvel
CiMone () Medium

Create internal nodes
[ ]Mesh internal Cavities
Ospeed O accuracy [ Boundary healing

[ ok | [Cancel] [ Reset ] [ Help ]

Large input Format:

Restriction of one million nodes and elements is removed. This feature enables
the user to have nodes and elements ID number beyond 1 million (I16) and up to
100 million (I8). This feature is available for NISA Il solver.

Neutral File Format:

Neutral file format is extended to support all Direct Frequency Response Analysis
data groups and MATDIR1, MATDIR2 data groups.

NISA Parametric Language (NPL):

MACRO is extended to support array parameters declarations and storage
(1D array).

DIMENSION XYZ[3]
GRD, ADD, 3, XYZ[1]/ XYZ[2]/XYZ[3] /0

MACRO is renamed to NISA Parametric Language (NPL) and the documentation
is revamped for easy syntax reference.
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5. Session Command:

Session command length is extended up to 512 characters and is no longer
limited to 74 characters. This feature enables the user to group string of
commands to perform various tasks in sequence.

Session command, “DIAG MESG” is added. This feature is useful to print the
assigned values of the variables, user defined strings, and evaluator output. RCR
needs to be set as ON to see this data.

DIAG, MESG, ***** (NDCOUNT) *¥eires
Features specific to DISPLAY IV
Meshing

1. Advanced Surface Mesher (ASM):

Advanced Surface Mesher (ASM) is extended to work with Trimmed Parametric
Surface (TPS) data. Using this feature, the user can mesh individual or entire
TPS data with the required meshing options. With individual TPS Meshing, the
connectivity between 2 adjacent TPS is not automatic. The user needs to ensure
the connectivity. If all the TPS are meshed together, the connectivity is
maintained.

FEM->Mesh->Adv Surface Mesher

AR w."th IR Entire TPS data meshed with ASM
in DISPLAY
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Performance and Improvements

Lighting and shading parameters are fine-tuned to get realistic view of the model.

Enhanced the performance of key operations such as node merge and all delete
operations in the range of 60 % to 90 %. Speed of hidden line plotting and
shaded view for elements is improved in the order of 60 %.

4, Post processing of contours: Continuous color contour is made as default where
as the conventional 14 color band plotting is made optional.

While plotting contours, graphs and history plots the view area is optimized.

Graphical window and the Entity/Workspace window are improved to work
independently.

7. Gradual rendering of the entities is implemented.
Report Generation

8. Report generation for both pre and post processing is added to automatically
generate HTML and Word document reports.
Tools—>Generate Report

ﬂ; C:\NISARUN\REPORTAbracket_v126. html - Windows Internet Explorer

ey~ |@C:\NISARUN\REPORT\hracketjl26.html v| +2|[x ‘

Eile Edit View Favorites Tools Help

w & [ (& CNISARUNYREPORTlbracket_v126 hikml I } -8 =
7. SYY-STRESSES 1358 3716 37 10052+001
8. SZZ-STRESSES 1360 e 37 1338001
©.  SXY-STRESSES 1837 11014000
10. SYZ-STRESSES 1358 7 30604000
11. SZX-STRESSES 1837 20714000
12. 1-PRNCPL.STRESS 13355 37 1.780e+001
13. 2-PRNCPL.STRESS 1828 37 4737000

14. 3-PRNCPL.STRESS 1380 5 24382001
15 MAX SHEARSTRS. 3141  0000=000 1837 22542000
16 VONMISES STRESS 3244 DO0D=00D 1837 1607=-001
17. OCTAHEDRAL STRS 3244 0000000 1837
18, TRIAXIALITY 1355 9306001 1848 6805

19. STRESS-INTENSITY 3244 0000000 1837  170Le001

“ Report Generation E|rz| Images
) CRPLAY IV - GEQMETRY MOCELINS SYSTEN (1700 .
Report Options Report Options ' et
Model Properties File Location
Property Data E:\NISARUMIREPORTIPRIL426. htmnl
Material Data
- i E:NNISARUM\REPORT ‘
Boundary Conditions| ~ Crectory ‘ ! ! [ Browise... ]
{IEELEE File: Name ‘ PRIL426. html ‘
Report: Format Htril Format w
Import Styleshest | ENISARUMIREFORTIPRIL42 ‘ [ Erowse. .
< )
4 My Computer
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User Interface

9.

10.
11.

12.

13.

14.

15.

The tree structured menu in the workspace area is enhanced for quick and easy
access of the menu items.

Session commands are displayed in the dialog boxes.

Nodes and Elements data is presented in a text format. The user can further
utilize this data.

View->Entity Information

Post Toolbar is appended with forward and backward arrows to change the load
case or time step number. This helps user to post process the results without
using post status dialogue. This feature is available in Linear and nonlinear static
analysis.

Command Syntax help is provided as user types in the session command
window. After 2 levels, the entire command syntax is shown as a tool tip.

3: grd add |
grd add/GRD, 4DD. OUTPUT-ID. £-¥-Z-LCS-1D |

A “Measure” toolbar is provided to measure linear length between Grids and
Nodes. Also, the linear length is measured for the selected line.

Measure 0Op...

Entity tree options are enhanced to list Boundary Conditions and Analysis data.
Operations such as modify, search, add IDs can be executed from the entity tree
(Workspace window).

..... —
- 2 | =43 Entities ~
@ = + work Plame
= ' * Q} Patch
+- Analysis

& | 8| =2-EC Boundary Conditions
x % = 3/* LoadCase 1

- Gt SetiD 1
@ = Jr{. Displacement
AR w R0 197

kel +1 Mode 202
i o 1 Node 27 arch
) +| todezaz  Erase
9 a +1 Mode 247 Plot
K? ‘E &1 hode 257 Delete

iy 4L Mode 475 RS
£ @ iJﬁ Mode 480  Copy

i L Mode 485
b E +1 Mode 520
o +1 Mode 525
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16. Context based menus and toolbars are provided. As per the context selection or
the files read, the corresponding menus and toolbars will become visible. The
following are the functional keys:

KEY USED FUNCTIONALITY
F2 Geometry Toolbar
F3 FEM Toolbar
F4 Analysis Toolbar
F5 Post Toolbar
Ctrl+Left mouse Button PAN
Shift+Left mouse Button ROTATION
Middle button click once + Left mouse ZOOM IN/OUT
button
Left button Double click once + Left Zoom Rectangular Box area
mouse button
I Isometric view
y4 Zoom To Fit
(0] Opens Orientation Window
Q Opens list of Recently used Dialogs
C or SPACE BAR Sets the cursor position to Command Window.
ESC Exits out from Full screen.
F1 Displays HTML Help
Pre-processing in DISPLAY IV
17.  Applying Boundary Conditions on TPS is supported for Structural BCs such as

Displacement, Pressure and Heat BCs for instance Initial temp, Specified temp

and Convection. After meshing, a

I the BCs applied on the TPS will be

automatically transferred to FE model.

Displacement BC applied on TPS

Displacement BC transferred to
meshed model

Cranes Software, Inc
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18.

19.

20.

Piezoelectric Analysis:

All the data cards required for the Piezoelectric - Static/Eigen/Ltransient Analysis,
are supported. Material data card *MATPIEZO for piezo material is added. 3-D
Solid Piezoelectric Element (NKTP = 6) and 3-D Membrane Piezoelectric
Element (NKTP = 8) are supported. Apart from the existing supported boundary
conditions, *ECDENSITY, *ECHARGE are supported for Piezoelectric analysis.

Direct Frequency Response Analysis

The data cards *FREQCNTL, *FREQFUNCTION are added. The boundary
conditions like *SPDISP, *CFORCE are extended for Direct Frequency
Response Analysis.

Facility to edit/modify the existing loads and boundary conditions is implemented.
This is feature is available using the right mouse operation of individual BC.
(Boundary Conditions—> Misc. Options—> Modify) as shown below:

\ 3 ¥

MNode #3

Erase

Delete

Search

Copy 3
Maove 4

Extract Grid
Madify 5¥Z Data

Misc, Options 4
Search
Boundary Conditions Skructural r Eearc
rase
Maodal Dvynarmic k ol
3D Fluid Incomp k F‘ID :'r 1 @
] 3D Fluid Compressible  » N L
— Reading NIZS 00 - : Delete
— Future SPDI3 Symbol Si
] e Heat 111 T s
- Madify
i : ] Misc, Options Copy .l -
MR HE L P Iy 5 -
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21.

22.

23.
24,

25.

Facility is provided to copy the nodes and elements along with the associated

boundary conditions.

®. Mode - Translate

LCS Type LCS D

Mo.of Copies

NOD,TES

| Cartesian % | | | | 1

| [Qutput Ds=... ]

[ ok H Cancel ” Beset

J[_tep ]

Using the option FEM->Data Groups—>Contact Elements—>Automatic, contact
elements and contact surfaces are created automatically based on a user
defined tolerance. ldentification of the bodies is based on material or property

IDs.

Pressure can be applied on a full plane by selecting 3 nodes.

Layer option is enhanced to append entities to an existing layer. Also layer

names are listed in the dialog boxes for selection.

=, Element IDs

b ethod Layer Hame
|La_l,lName v” v|
[ ok ] [ Cancel ] [ Beset ] [ Help ]

Import option is enhanced to support all CAD file formats allowing the various

CAD file formats importation using File=>Import.

Maztran Files [* nas,” bdf,”. dat)
Anzyz Files [*.ansg)

Sat Files [".zat]

IGES Files [".iges.” igg]

Adv |GES Files [*iges,” igz]

SH Files [*.2H)

Proe FEM Files [*.frf]

Pra-E Files[® prt,” prt.*, % asm.”. azm.™)
Catia'd Filez[" model]

Catia Files[* CAT part,” CAT product)
[reventor Files[™ ipt]

Step Files[" stp,* step)

G Files[" prt]

File name: | » | [ Open ]
Filez af type: Mastran Files [ nas,” bdf,”.dat) “w Canicel

Cranes Software, Inc
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26. Facility to define general shape beam section is provided. Data input form for
generally-shaped section is shown in the following figure. This is the main form
for these sections and the user can select the appropriate pick buttons to enter
data for nodes, members and cells.

*, BEAM General Sections @E
Froperty ID A7 eV
Section Mame
LibCarmpt arme
= el
Cex ) (o]
Iz section sprmmetric .
about v'-aris 7
[ Delete ] [ Rezet ]
Iz section summetrc
about Z-axis ? (] b aterial Librarny
| Libay File || Saveal |
(o] Caw )
l Beset ] [ Help ]
’_ LCloze ] [ Cancel ]
[ 0k l[ Cancel ]
I TCLOONME®=mIT

27. Using the option FEM->Elements>Modify>NKTP12 ->39, 3-D Beam Element
(NKTP = 12) can be converted to 3-D General Beam Element (NKTP = 39). The
cross sectional data of NKTP12 is taken from the #.dbs file.

28.  Assignment of existing beam elements (NKTP=12) as Weld elements is added.
Operations such as plot, erase, search and color are supported for these
elements. Static failure parameters (Maximum values of tension, compression
and shear) for welds can be input under *MATERIAL data card.

29. Generation of the K-node at the center of the curvature of an elbow is done
automatically.

Post-processing in DISPL AY IV
30. Direct Frequency Response Analysis

Contour plot of the responses like displacements, velocity, acceleration, stresses
is supported. Deformation, history plots are supported for Direct Frequency
Response Analysis. Post status form is added for Direct Frequency Response
Analysis in order to change Frequency and Amplitude/Phase.

31.  Writing multiple external results is supported.
32.  History plot for nonlinear results is now available from external results.
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33.  Viewing results for complete model from the symmetric model is available with
External results.

34.  Convergence plot of fluid flow and heat transfer analysis is added.

= TURBULENT KIMETIC EMERGY ERROR(® 1.78)

oy =

Amplitude

ns =

ne —

0o

Time

35. Post processing of Piezo Electric analysis is added.

Contour plot of the responses like displacements, velocity, acceleration, stresses
is supported for Piezoelectric - Static/Eigen/Ltransient Analysis. Deformation,
history plots are supported.

36.  Animation control is enhanced to create GIF output files option and the option to
have only animation is introduced.

37. Post processing of reaction forces is incorporated. The values of reaction forces
and moments are written along with the constrained nodes in the view area and
an option provided to write the same in the information window.
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38.

Static failure contours for weld elements (*\WELEMENTS) are made available

under Post Results | Misc. Results | Weld element results. Tension, compression

and shear failure contours are supported.

DISPLAY IV - GEOMETRY MODELING SYSTEM (17.0.0)

Spotvwelds

TEMZILE STRESS
ThAX=1123E-01
WIEW : -.5490468

RANGE: 0.5745241

.: 01123

Cranes Softweare, Inc
06/23/2009 18:46:37

¢
| Niza

39.

Combining Linear/Nonlinear and Dynamic analysis results and writing to the

output file for Shells and Solid Elements is added. To access Post>Misc

Results> Seismic Analysis
40.

Option to view composite post results for many elements at a time is added.

" Response Results

TAUXZBOT).EL=53 HILLMISES EL=D Sx EL=E0 S EL=E0

TAUXZ[BOT)EL=E0 HILL-MISES EL=E0

1 5.2800=-004 1 1508333

2 977434

4 1.95437 4 215478

*x« 87743
8 dspsEm

1 1368408
2 1077381
Foeamzm 0 [3ogesElr

1 B.1700e-004

5 61200004
B I

5 EL=R1

SYY EL=E1 TAUXZ[BOT)EL=E1 HILL-MISES EL=E1 SeEL=E2 SYYEL=62 Masimum
1 1677530 1 1587240 1 68000004 1 17.90290 1 17.46307
2 11.33743 2 11358279 2 1247362 2 1278779
TR BRI
4 226749 4 2.39656 4 245472 4 256756 E
718 v
e
1133743 7 1247362 7 12T i
B e B A7ame B oaTEDE #
Miniirnum
TAUXZ(BOT] EL=E2 HILL-MISES EL=E2 S0 EL=E3 SV EL=63 TAUNMZ(BOT) EL=E3 HILL-MISES EL=E3
1 7.2100e-004 1 1854619 1 1842826 1 7.4300e-004
2 1316304 2 1324657
4 253 4 2.649
5 7.1400e-004 5 7.3600e-004
71316304
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CAD TRANSLATORS
Sat2Neu, CATIA V4/V5, Pro/E, Inventor, UG, STEP, Adv. IGES to DISPLAY Neutral

All Translators are upgraded with ACIS R19 to support following CAD system versions:

Version supported versions
File Format File Extensions with NISA 856 supported with
NISA V17
CATIA4.1.9 -
CATIA V4 #.model, #.exp No Change
CATIA4.2.4
V5R2 - V5R19
#.CATPart,
CATIA V5 # CATProduct. V5R2-V5R16 V5R17->V5R19
(new)
IGES #.igs, #.iges No Change Upto 5.3
: Inventor Versions 6, 7,
Inventor #.ipt 8, 9 and 10 6 - 2009
11 - 2009
: Assemblies are not
#.lam supported Assembly support
(new)
| 16 — Wildfire 4
Pro/E #.prt.* #.asm.* Pro/E 16 to Wildfire2
Wildfire3-4 (new)
AP203, AP214
STEP #.stp, #.step No Change (Geometry Only)
UG versions 11 to 18 11to 18, NXto
Unigraphics #.prt and versions NX1, NX6
NX2, and NX3
NX4-6 (new)

1. Translate as sheet bodies option is supported for IGES part files. To access from
Application Launcher Settings—> CAD Translator
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FEA TRANSLATORS
FE data translation from NISA to ANSYS

1. Nodal temperature and temperature difference (*NDTEMPER and *NDTEMPDIF)
are supported.

2. Plane stress triangular element NKTP=1, NORDR=10; axisymmetric element
NKTP=3, NORDR=1, 2; torsional spring element NKTP=21, NORDR=1;
laminated general sandwich shell element NKTP=33, NORDR=2, 11; thin shell
element NKTP=40, NORDR=1 are supported.
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PROCESSORS (SOLVERS)

NISA I

1.

Large input format:

Restriction of one million nodes and elements is removed. This feature enables
the user to have nodes and elements ID number beyond 1 million (I16) and up to
100 million (18).

Shifted block-Lanczos eigen solver:

A multi-shifted block-Lanczos feature is introduced for faster eigenvalue
extraction of large structures requiring higher number of modes. For example, to
extract 1800 eigenvalues for a structure with 170,860 active DOF the
computational time saving is 87 % as compared to Block Lanczos.

Direct Frequency Response Analysis:

User can analyze structures under support excitation with specified amplitude
and phase spectra.

Spring (NKTP=17, 21) and damper (NKTP=48) elements can now be modeled
with frequency dependent characteristics.

Computation of derived quantities is possible with a restart option.

The analysis is suitable for analyzing structures with damper elements to
simulate for example, shock absorbers. Also, for large structures the direct
frequency analysis is expected to yield more reliable result compared to modal
frequency response analysis.

Contact Analysis:

A robust Lagrangian algorithm for surface to surface contact element is
introduced to model both 2D and 3D contact elements. User input is minimized
with respect to the penalty parameters. The concept of pinball region is
introduced in order to reduce the search time over the contact surfaces. On
defining the pinball region, the search process is confined to this small region
around the slave node, thereby making the search process faster and accurate.
This method, however, works only with the PARDISO solver.

An option is introduced in parallel solver (PARDISO) to make the system use
either in-core or out-of-core memory. For very large sized problems when the
system RAM is insufficient the solver can be made to use the system hard disk
space by selecting the out-of-core option in the solver type.

The tapered beam element is modified to provide an easier way to specify the
beam cross sectional variation.
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10.

11.

12.

13.

14.

User Plasticity and Creep routines interface using DLL interface:

User plasticity routines interface using DLL interface is added. This feature
enables user to provide his own DLLs, using any programming language, for
specifying the plasticity model.

Auto constraining rigid body motions for inertia relief:

In inertia relief analysis, user is required to constrain the free body motions. The
new feature can automatically select the right boundary conditions to take out
rigid body motions without over constraining the body.

Failure criteria for composite shell element in nonlinear analysis:

User can input the strength properties in *MATERIAL data group to evaluate
layer failure based on maximum stress, Hill-Mises, Tsai-Wu, and Tsai- Hill (Tsai-
Hill criterion can be replaced by a user-defined criterion) criteria for nonlinear
analysis also.

General beam element (NKTP=12) is added to nonlinear analysis for special
application:

General beam element (NKTP=12) is added to nonlinear analysis for special
application where the beam elements are in linear condition and the joint springs
are under plastic deformation (plastic joint). This special feature is used in
NISA/CIVIL module.

User specified coefficient for AUTO constraint:

User is provided an option to specify a fictitious value for torsional stiffness of the
normal rotation (drilling) DOF of shell element in executive card.

Partial Fixity:

Partial fixity is a special feature for beam elements (NKTP=12, 39) to simulate
plastic joint condition. It allows the specified percentage of beam end forces to
transfer to other beam member at the beam joint.

Improve available memory for sparse solver:

The available memory for sparse solver is estimated internally by subtracting the
memory size provided in executive card in input NISA file from the total system
memory. This facility helps the sparse solver to optimize the usage of available
RAM without utilizing the swap memory. User still has the option to input the
sparse solver memory size, in case the estimated memory is insufficient.

Static failure of welds:

Static analysis of welds for failure in, tension, compression and shear is available
with the implementation of a new data card - *WELEMENTS. The welds can be
post processed in DISPLAY IV.

Cranes Software, Inc 18 of 38 July 2009



Release Notes Version 17.0

15. Eigenvalue Analysis Restart 2:

This restart feature is useful in modal dynamics run. With this option, user can
run eigenvalue analysis again with *MODEOUT and *EIGOUT cards activated, in
order to obtain the modal stresses, reactions, internal forces and/or pseudo static
solution of missing mass correction.

If pseudo static solution is activated, a new pseudo static solution is computed
and overwrites the one from the previous run. Since the pseudo static
computation requires stiffness and mass matrix, both file 23 and 24 should be
saved from the previous run.
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ADVANCED DYNAMICS

1.

Critical damping value for material damping data in *MATDAMP:

User can now specify the critical damping value (CDAMP) for which the default
limit is 0.2. This limits the computed modal damping to CDAMP value if it
exceeds this specified damping value.

ROTOR DYNAMICS

1. Parallel solver (PARDISO) is supported for rotor dynamics for large problems
and faster computation.

ENDURE

1. Fatigue of spot welds:
A new feature for estimation of fatigue life for spot welds in the structural
components is implemented. The structural stress method is used where the spot
welds are modeled as circular beams. The new data card * WELEMENTS is
introduced #.NIS file and the corresponding weld material and dimensional
properties are automatically extracted. An option for plotting the weld contours is
provided in Endure Shell.
This feature is especially suited to life estimation of spot welds in automobile
components.

2. Enhancement of Endure Shell:

User can specify any material ID number (previously it was limited to the
sequential numbers 1 to 5).

For Initiation module, a) the dialog boxes are re-organized to make it user
friendly for defining input load, b) option for plotting #.a and #.b post files is
made available only in DISPLAY 1V, c) user needs to specify only ‘post file
prefix’. Consistent file name for output is automatically chosen by the program
and d) user needs to choose only #26.dat file for pre- and post-processing. The
#27.dat file is automatically identified by the program.
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EMAG

1.

MEG independent execution is introduced. The MEMORY executive data card
can be used by the user to avail this facility. This feature fully utilizes the
available system memory.

HEAT Il is incorporated in EMAG. This facility enables user to utilize the
enhanced features of HEAT llI, to solve coupled EMAG, heat problem.

An option is introduced in parallel solver (PARDISO) to make the system use
either in-core or out-of-core memory. For very large sized problems when the
system RAM is insufficient the solver can be made to use the system hard disk
space by selecting the out-of-core option in the solver type.

Option is provided to remove negative pivot in system matrix for iterative solver.
User should be aware that iterative solver can only solve problems with positive
definite matrix. This new option is to modify the negative pivot due to, for
example, bad elements in the model.
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NISA/CIVIL
Modeling (Pre-processing)

1. Geometry based building wizard is introduced in NISA/CIVIL to facilitate the user
to easily model floors in a structure, which can be further analyzed and designed
by specifying the columns and loads data.

Create Floor Plans
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2. Flat slab modeling is extended for irregular geometries also. With a set of easy to

use tools, the flat slab geometry can be defined and the shell model is generated
automatically, which can be graphically verified by the user. The design strips
identification can be automatic or user specified. Analysis and design can be
performed from the integrated environment itself.
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3. Scripting is introduced in NISA/CIVIL for FE modeling through command mode.

4, ASCII input file with extension *.prc is introduced in NISA/CIVIL.

Analysis

5. A facility is introduced to specify partial fixity at selected beam ends.

6. Member local offsets for beam elements have been introduced.

7. A facility is introduced to offset the shell elements to facilitate the realistic FE
modeling.

Design

8. Structural design of steel members subjected to axial compression, tension,
bi-axial bending and shear forces conforming to IS 800:2007 has been
implemented.

9. Structural design of steel members subjected to axial compression, tension,
bi-axial bending and shear forces conforming to BS EN 1993-1-1:2005 Euro code
3 has been implemented.

10.  Structural design of concrete members such as Reinforced Concrete (RC) Slab,
RC Beam, RC Column, RC footings, RC Shell elements & RC Retaining walls
conforming to BS EN 1992-1-1:2004 Euro code 2 has been implemented.

11.  Structural design of gravity walls conforming to IS 456 -2000 has been
implemented in interactive mode of design.

12.  Structural design of well foundation conforming to Indian standards has been

implemented in interactive mode of design.

Well Design

‘wiel Particulars | | oad Particulars

Wiell Details WELL CAP
= | |

M 3 Output Units 3

s ild | Girade of Concrete Iy
: B r T

Erteinel Disodi el ! wellcap N/Sqmm) 19 SANDFLLLIN o e WELL STEINING

[37 .... : Sy
R ! ! el Staining ES I—

[7e0 NS -
‘well cap Thickness [mm) | 750 (esaimm] SCOURLEVEL
WellBapTon kel [mm) {390 wiell curb Details

- Dffset [mm] 75

Steining Thickness (mm) 1500

g Height [rarm) E)

BOTTOM PLUG

Top plug thickness [mm] 1500 X

: Battorn width [mm) |150 CUTTING EDGE w
Bottom plug thickress [mm) | B00 ——%

Bar Dia [mm] 20
Steining Ver Bar Dia [mm] 12 !

S | Concrete Grade o

(M50 mm) 20 [Lunts | [[(oesn | [0 |

Steining Har Bar Dia (mm) a

IR

Cranes Software, Inc 23 of 38 July 2009



Release Notes Version 17.0

13.  Structural design of bridge piers (solid type) and bridge bearings (neoprene) as
per Indian standards is implemented.
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14.  Structural design of irregular flat slab conforming to Indian, British, American &
Euro codes of practice is implemented.

Post-processing

15. Auto rationalization of reinforcement for shear wall is introduced along with a
user friendly detailer for further rationalization as per user requirements.
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16. Computation of storey drift in pseudo static seismic analysis for framed structures
is introduced.

17. ldentification & detailing of column strip, middle strip in regular/irregular flat slabs
and their re-bar arrangement has been introduced.
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Drawing

18.

introduced.

19.

Automatic generation of structural drawings for

irregular flat slab has been
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Automatic generation of shear wall profile in structural layout plan and as well

enlarged views showing structural details of shear walls in tabular format-floor
wise is introduced.
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Floor wise detailing sketches of Shear walls
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20. Automatic floor wise rationalization of columns with respect to re-bar and their
cross sections is implemented.

21. Automatic rationalization of RC Slabs with respect to
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spans and their thickness is implemented.

re-bar, edge conditions,
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22.

Generation of general arrangement beam drawings showing plan, longitudinal

and cross sections are improved. Automatic rationalization of beams with respect
to re-bar, cross sections within the floor and user specified floors.
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User Interface

23.
background gradient option, etc.

Improved Ul with icons introduced for most of the functionalities, graphic window
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24.  Tool bars property is now made as undocked so that user can move them around
the Ul and locate as per user preference.

25.  With edit operations, the pop-up menu for selection options is docked to the
dialog.
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ERROR CORRECTIONS

PRE & POST PROCESSORS

DISPLAY Il

1. Pressure/nodal thickness contours do not plot if same property ID is used for
both quadrilateral and triangular elements — Fixed.

2. VEW HID ON is not showing hidden view for some elements when selected
using window — Fixed.

3. Problem with adding beam section properties through command mode — Fixed.

4. Session file not reading temperature dependency curve ID applied in property
form correctly — Fixed.

5. Problem in writing external results only for active entities. If there is a greater
number of load cases, after writing external results for 39 or 40 load cases,
DISPLAY gives error — Fixed.

6. DISPLAY Il is not plotting lamination angle plot for a composite problem if
LAMSQ?2 is defined — Fixed.

7. When negative pressure value is given and defined with vector ID, arrow is not
plotted in opposite direction and arrow is always plotted in the direction of the
vector — Fixed.

8. DISPLAY crashes for history plot when history is not requested in the NIS file —
Fixed.

9. Launch Advanced Surface Mesher, click on Add and press Esc key on the
keyboard twice, DISPLAY hangs — Fixed.

10. Advanced Surface Mesher, Mesh parameters window does not pop again if it is
closed with "Esc" key — Fixed.

11.  Advanced Surface Mesher shows wildcards for number of nodes and elements if
more than 10E5 — Fixed.

12. Not reading *SPDISP,*CFORCE data in NISA file for Linear Transient Analysis

using Piezo elements — Fixed.
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DISPLAY IV

1.

10.

11.
12.
13.
14.

15.

16.

17.

18.
19.
20.

21.

Beam splitting limitations of using values like 1000 or more causing unexpected
behavior — Fixed.

Layer dialog in DISPLAY IV not working as per windows standard — Fixed.
Large icons were not saved in the user settings ini file — Fixed.

Swapping of data in Moving Load data card under Transient Dynamic analysis —
Fixed.

Image saving should query the user if the image file with the user specified name
already exists — Fixed.

Missing icons in all Analysis tool bars — Added.
Font color is not changing after selecting color in font dialog — Fixed.

Analysis/Fluid+Heat->Material>Fluid, Ratio of Specific Heats (GAMM) remains
unchecked with “Add” — Fixed.

Analysis>NLStatic>Plastic card's combo boxes problem, when user selects
"concrete" from Elasto-plastic material "user defined model" combo should be
disabled but is enabled — Fixed.

Boundary Condition data related to all analysis is not getting replaced or
appended — Fixed.

Offset option for shell elements is not reflected in realistic plot — Fixed.
CST, FORM command hangs — Fixed.
Problem with load/save material library file — Fixed.

Discrepancy with macro execution that after empty input values, negative values
and giving an input file there is no action — Fixed.

Analysis/Heat->Property, Matdirl, Matdir2, Lamangle and Lamsequence2
remains unchecked even after adding the values in respective data — Fixed.

DISPLAY IV not saving the modified files if the input file (all supported DISPLAY
IV file types) is from Application launcher or through command mode — Fixed.

In EMAG Pmagnet data value was not accepting Real or float values and
prompting to enter between 0 to 100 — Fixed.

Geometry->Circle with Ring option gives full circle — Fixed.
Direction arrow size is not proportionate to the entity size — Fixed.

After Edit->Erase, FEM->Element->Misc Option>Plot with All option also
displays BCs — Fixed.

Proper images not saved with image saving command while in session or macro
mode — Fixed.

Cranes Software, Inc 30 of 38 July 2009



Release Notes Version 17.0

22.

23.
24,

25.

26.
27.

28.
29.
30.
31.
32.
33.
34.

35.

36.
37.
38.
39.
40.

41.
42.

43.

44,

In post processing of file when we select Phase plot, the model disappears and
only boundary condition is displaced on the screen — Fixed.

NISA logo not available in the screen while viewing post results — Added.

Information window is having problem. In case of operations like Automesh,
deletion of entities in larger numbers etc, which need to show messages
continuously, information window goes blank during entire operation and shows
the information only at the end — Fixed.

In DISPLAY 1V, for all Analysis—>Executive dialog, "Enter File Name Prefix" is not
updating with user given file name prefix — Fixed.

File name is not seen on reading the NIS file — Fixed.

In View—>Solid cut section, Add planes using Grid/Node Ids and after selection of
Grids / Nodes, DISPLAY 1V crashes — Fixed.

Problem in creation of Rectangle and Circle on user-defined Workplane — Fixed.
Boundary Condition color not changing on Plot — Fixed.

Problem with setting the color for layer — Fixed.

Modifications of Layers dialog for ease of use — Fixed.

Some dialogs are not appearing when model is in fly view — Fixed.

Tool tip in Analysis tool bar displays wrong information for some icons — Fixed.

Unnecessary messages are shown in information window for realistic plot —
Fixed.

Error while compacting the Node IDs as “Error in {MAVAIL}. Module un-defined.
Il Please report” — Fixed.

Cancel button not doing proper job where incremental ID is present — Fixed.
Heat Analysis toolbar icons are wrong — Fixed

Beam offset issue while using rectangular cross-section — Fixed.

Crash in using domain handlers with translated geometry — Fixed

During post-processing toggling between Contour plot, Graph plot, and again
Contour plot, results in the color bands and titles to be missing from the Contour
plots — Fixed

More than 512 characters in command line causes DISPLAY |V to crash- Fixed

Method of Formulation of Hyper elastic Material (HYPER) is blank after saving
and reading from a NIS file — Fixed.

When negative pressure value is given and defined with vector ID, arrow is not
plotted in opposite direction and arrow is always plotted in the direction of the
vector — Fixed.

Beam elements seem broken while plotting post contours, with the exception of
von-Mises stresses— Fixed.
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45.  With menu Elements->Composites>Single Set for a 3D Laminated Composite
General Shell element gives Memory error — Fixed.

46.  Problem with general shape C section if the feed value in metric system — Fixed.
47.  Flexi grid copy and paste not working — Fixed.
48.  Animation in DISPLAY IV is slow when compared to DISPLAY Il — Fixed

49. Executive setup shows untitled file if a NIS file is opened from Recent file list —
Fixed.

50. Geometric Association for Element selection along with Field quantity for
pressure is not working — Fixed.

51. Reading nis/dbs/neu/dat/ses file is not working if space is there in the file path —
Fixed.
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CAD TRANSLATORS

1. SAT/IGES to Neutral convertor problem while converting more than 126 parts —
Fixed.

2. IGES issue for converting sheet body files — Fixed.

FEA TRANSLATORS

FE data translation from NISA to ANSYS

Pressure was being applied to wrong surface on NKTP = 4- Corrected.
Handling of multiple load cases corrected.

NKTP=33, NORDR=1 was being translated to SHELL91- Changed to
SHELL181.
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PROCESSORS (SOLVERS)

NISA I

1. In nonlinear static analysis using arc-length scheme with SPARSE or iterative
solver, the program crashed if arc-length scheme was used after the first event —
Fixed

2. Arc-length method crashes if number of arc-length steps in one event was more

than 53 - Fixed
3. Unnecessary file FORT.4 was created using ITERATIVE solver — Removed.

Incorrect reactions for inertia relief if there is a rotated coordinate system defined
in the model - Fixed

5. NISA2 crashes in eigenvalue analysis using Guyan reduction method with
lumped mass formulation — Fixed

6. For moving path (Linear Static Analysis) has a segment in a triangle elements
(NORDR=10 or higher), NISA2 issues an error message "cannot find continuous
path"- Corrected.

7. Error of zero record for file 26 in element stiffness and load calculation in
nonlinear analysis with composite element using *LAMSQ2 data card with IESHR
(Key to activate equivalent transverse shear modulus computation) = 1 - Fixed

8. Nonlinear beam element (NKTP=39) reports incorrect beam end moments when
beam orientation is defined using a vector — Fixed

9. Vector to define beam orientation is not consistent in linear and nonlinear
analysis for NKTP=39 - Fixed

10. Beam load results are incorrect if beam offset is defined in beam local axes —
Corrected.

11. For PARDISO Solver Wave front optimization is to be skipped — Corrected.

12. PARDISO solver crashes with MPC equation. PARDISO solver interface handled
MPC with BC incorrectly — Corrected.

13.  Problem cannot converge in nonlinear analysis with MPC equations using CASI
sparse solver — Fixed

ADVANCED DYNAMICS

1. Dynm2 is crashing for centroidal stresses for shell elements — Fixed.

2. ZPA computed using CFREQ is not scaled up with scale factor in *GROUND -
Fixed

ENDURE

1. Error in life estimation using User Defined S-N data — Corrected.
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NISA/CIVIL

1.

10.

11.

12.

13.

14.

15.

The data specified in ‘Bridge Form’ dialog was not retained after exiting the
dialog — Fixed.

In ‘New project’ dialog, Default Units for Input and Output units were disabled —
Fixed.

In ‘Load Cases & Combinations’ dialog, selection of P-Delta Load case ID from
"Dynamic/P-delta Load Case ID" combo box resulted in run-time error — Fixed.

In ‘Load Cases & Combinations’ dialog, with the selection of Dynamic Load case
ID from "Dynamic/P-delta Load Case ID" combo box, the 'Base Shear' values
listed against the defined 'Rules' were not updated (values belonged to the
project opened earlier in the same session) — Fixed.

Execution time for Beam drawing generation reduced considerably.
In the Layout drawings, the member offsets for columns were incorrect - Fixed.

Exiting ‘Selection Method’ dialog after storing Ids through graphical selection,
graphic window retained "End Selection" & "Reset Selection" buttons and the
menus were disabled (performing Elements\Add between Nodes through ‘Pick
nodes’ option and without quitting that mode, immediately performing Id selection
through ‘Selection Method’) — Fixed.

For steel design against high axial force, the program generated Fortran error
and crashes out (with Codes of practice "BS: 5950-2000", "AISC-ASD-2005",
"AISC-LRFD-2002", "AISC-LRFD-2005") — Fixed.

In a New Project with no data, selecting Member information with Listing of
design results, accessing design summary or using erase options such as
Border/Border crossing resulted in application crash — Fixed.

When the coordinate origin was not (0,0) for the structure; In Layout sketch, the
Horizontal gridlines were shifted — Fixed.

In Flat Slab Detailer with American Code of practice, when bar diameter was
changed, program issued message to limit maximum spacing as well as
minimum spacing — Fixed.

In Flat Slab Detailer using the American Code of practice, when the bar diameter
or spacing was changed, the program issued a minimum spacing message.
Program changed the parameter against cancel operation also. Further,
generating drawing resulted in run-time error — Fixed.

In the bar diameter text box, when ‘0’ was entered temporarily, and later changed
to a valid diameter, the program generated a run-time error — Fixed.

In Flat Slab Detailer, the bar diameter was changed for only one of the panels.
But, generated drawing includes Quantity Table for bars — Removed.

For American Code of Practice, the bar spacing was represented with 14 digits
precision — Fixed.
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16.

17.

18.

19.
20.

21.

22.

23.

24,

25.

26.

27.

28.

29.

30.

31.

32.

Typical section sketches represented reinforcement protruding beyond the
section outline — Fixed.

RC Column Design Report: With alphanumeric group IDs for columns, execution
of design report against Indian Concrete Codes of practice IRC-1966(Rev-2000),
IS-456:2000 Working Stress and 1S-3370-1967 resulted in run-time error — Fixed.

Execution of design report for columns with Uni-axial moment ‘My’, the
application crashed — Fixed.

For Circular Columns, tie details were not listed in summary table — Corrected.

RC Corbel Drawings: For default data, bottom stirrups along the sloping edge
were projecting beyond the corbel edge Line. Also, line color for Bars &
dimensions were same (also not uniform with other sketch components) —
Corrected.

For units other than “SI”, bar caption was represented with large precision —
Fixed.

Quantity Table exceeded the Plot Area Limit (mixed with the Notes area) — Fixed.

Retaining Walls: Counterfort Retaining Wall Plan View drawing did not have any
Title. For Counterfort defined only on Heel side, drawing represented counterforts
at Toe side also. Top width of Counterfort at Heel was not dimensioned — Fixed.

For Retaining wall of Type-3 (with Key), the Key width listed in CAD dialog was
incorrect — Fixed.

For Free Standing Stair, 'Drawing Settings' button was enabled after design
completion. Clicking the button resulted in a Run-time error — Fixed.

When Design Summary for Footing was selected, right click options in graphic
window became inactive (un-selecting the option did not change the status) —
Fixed.

‘Layout editor’ menu item was disabled for a framed structure project (by opening
the framed structure project after opening an interactive project) - Fixed.

When the element IDs exceeded the total number of elements present, launching
Layout editor resulted in Run-time error — Fixed.

Dialog caption ‘Structure Layout Editor’ as described in user manual is not
maintained in the application — Corrected.

For an interactive project already designed with ASD-2005 code, opening the
project in a new session and directly executing Design Report listed only
summary table for output writing and the report had only the table title (No
member design output & summary values) — Fixed.

For Beam Drawings, Table for Shear Reinforcement and Longitudinal Section of
Beams overlapped — Fixed.

While Property data was not defined for some of the members, generating Steel
GA Drawing resulted in run-time error — Fixed.
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33.

34.

35.

36.

37.

38.

For Analysis report including Tension Only/Compression Only elements, the
generated report has BLANK spaces as entries. Also, all the data columns for
Element Information are mismatched — Fixed.

For Analysis report generated against Dynamic Load case, with the selected
dynamic load combination rules for printing are not specified for analysis, the
report entries format is not maintained — Fixed.

For Analysis report generated against Dynamic Load case, with nodes selected
for Reaction or Displacement, the application generates Runtime error and
crashes - Fixed.

In the Import structure preview window, shell elements are not plotted properly —
Fixed.

For elements split option with shell elements, ‘No of Divisions’ field is enabled —
Fixed.

With Gravity as Y vertical, in the Layout Editor, the views caption, and the
displayed view are mismatched — Fixed.
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LICENSING & PACKAGING ENHANCEMENTS

1. This version supports time stamped soft licensing for Windows XP 64bit O/S and
VISTA (Business, Enterprise and Ultimate) 32-bit and 64-bit platforms which had
some limitations with earlier version.

2. NISA Modules, CAD Translators, and Manuals are packaged in a single DVD.
(Distribution of NISA on- CD ROM is discontinued)

O/S SUPPORT

This version of NISA is targeted for 32-bit as well 64-bit platforms. The Operating
Systems supported are:

1. Microsoft Windows XP (SP2 & SP3)
2. Microsoft Windows 2003 (SP1)

3. Microsoft Windows Vista® (Home, Ultimate, Business & Enterprise Editions)

Cranes Software, Inc 38 of 38 July 2009



	NEW FEATURES
	PRE & POST PROCESSORS
	Pre-Processor in DISPLAY III & DISPLAY IV
	Features specific to DISPLAY IV
	Meshing
	Performance and Improvements
	Report Generation
	User Interface
	Pre-processing in DISPLAY IV
	Post-processing in DISPL AY IV


	CAD TRANSLATORS
	Sat2Neu, CATIA V4/V5, Pro/E, Inventor, UG, STEP, Adv. IGES to DISPLAY Neutral
	FE data translation from NISA to ANSYS

	PROCESSORS (SOLVERS)
	NISA II
	ADVANCED DYNAMICS
	ROTOR DYNAMICS
	ENDURE
	EMAG

	NISA/CIVIL
	Modeling (Pre-processing)
	Analysis
	Design
	Post-processing
	Drawing
	User Interface


	ERROR CORRECTIONS
	PRE & POST PROCESSORS
	DISPLAY III
	DISPLAY IV

	CAD TRANSLATORS
	FEA TRANSLATORS
	FE data translation from NISA to ANSYS

	PROCESSORS (SOLVERS)
	NISA II 
	ADVANCED DYNAMICS
	ENDURE

	NISA/CIVIL

	LICENSING & PACKAGING ENHANCEMENTS
	O/S SUPPORT

